TROTEC USER GUIDE

Speedy500° trotec

iSave time! Read the SOP!

Before beginning this process make sure your job is suitable for Laser Cutting — 2D designs using
materials on the Approved Material List only.**

Using the laser is like sending a job to a printer, but with a few more steps. The laser can carry out cuts,
etches and scores using a single Adobe lllustrator file*. In order to ensure the job sends and cuts or etches
correctly, we must ensure that the file is set up correctly and that the laser settings we select are correct for
the material being processed.

This document is broken down into a workflow of five steps and a troubleshooting section.

Step 1: lllustrator Set Up

Step 2: Print Dialog

Step 3: Job Control & Preparing/Running the Laser
Step 4: Emergency Shutdown Procedure

Step 5: Maintaining the Laser

Troubleshooting

*You can use other software to design your file such as Inkscape or Corel. However, this is not recommended
as files will ultimately be sent to the laser through Adobe lllustrator. If you must use another program use this
guide for document/cut/etch parameters and export as PDF.

**If your material is not on the Material lists you MUST submit it for testing by technical staff. Allow 48hrs for
testing.
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How to make a file for laser cutting

Millimeters

1. Create a new document with the following parameters;
Max. document size @SoAD 1200mm W x 700mm H
@Physics 800mm W x 500mm H
Colour Mode RGB (not CMYK)
2. File > Save As uNumber_projecttitle_versionnumber.ai
i.e. u12345678_123DMake_v2.ai

RGB Color
We recommend creating separate cut and etch layers in your file.

More Settings

File Parameters

You must use the parameters below to transmit cuts and etches to Job Control (JC), the laser cutter
software. If your settings are as per below, but are not showing up in JC, check the Troubleshooting
section at the end of this document, or ask a MakerSpace mentor or staff member. Note: not all materials
have a setting for vector etching — speak to MakerSpace staff if you would like this setting added.

Vectors
[ Ras(’g_e rt E}?g e Vector cuts will be performed in the order the
QQOO Images, graaients, filea areas lines/shapes are drawn.

)© eoeoe RGB I?ack « Remove Hill’ from inside cut vector shapes
99 eee@ (O’g’roé?; S%g?eooo e Clipping masks will not work on vectors. Trim
> © ea‘ y vectors using the Pathfinder or Scissor (C)

D ¢ tools.
% = Vector Etch —
% outlines, scoring, partial cuts
RGB Blue e Check the materials library to see what effect
f (0,0,255) or #0000FF you desire for your material and choose the

DQQO& 0.001mm or 0.025pt appropriate greyscale tones.

)0 O5 ¢ High contrast B&W images etch best, use

g OOO OC Vec tor CU i Photoshop or similar program to convert images

to greyscale and/or change their contrast.
through cuts

RGB Red HENIS

(255,0,0) or #FF0000 o Fonts must be ‘Expanded’ (Object > Expand)
4 0.001mm or 0.025pt and assigned cut or etch parameters before
exporting from personal computers.
Use an vector hairline for positioning marks: (0,255,255) or #00FFFF, 0.001mm or 0.025pt

Type Select Effect View W

Transform >
Arrange >

El=1a 100%
Group 86

Lock >

Hide > ,

Rasterize...

Select Color:

OH: 0°
Os: 100%
OB: 100%

R: 255
QG: 0
OB: 0
# 10000

(] Only Web Colors

N Select colour N Remove fill from vectors N Expand text
If you haven’t already, File > Save As uNumber_title_revision.ai (i.e. u12345678_123DMake_v2.ai).
Be sure to select ‘Include linked files’ in the save menu.
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How to send a job to the laser cutter

Print

1. Open your document (Al or PDF) in Adobe
lllustrator on the laser cutter computer

Print Preset:  MakerSpace

Printer: Trotec Engraver v10.6.0

. . . neral General
2. Prlnt (Flle 9 Prlnt) ::rks alndBIeed Copies: 1 [ Reverse Order
:::::; Artboards:
. . Color Management [ Ignore Artboards

3. In the lllustrator print dialog, select the — Madia Stz Dofined by Driver

MakerSpace ‘Print Preset’, which sets the

fOIlOWing' Orientation: [] Auto-Rotate @ F4 @ B

Printer: Trotec Engraver -

Print Layers: Visible & Printable Layers v

Orientation: uncheck AutoRotate

Scaling: Do Not Scale

Placement: X: 0 mm Y: 0 mm scal:

Document: 210 mm x 297 mm
Media: 500.04 mm x 800.02 mm

4. Enter the JC ‘Printing Preferences’ dialog: setw..

Click > [[Preforences

General Favorites Print

5 Inthe Print’tab: . -
|

i.  Select your Material Settings Size Settings
F; User-defined Size v Width mm
ii. — Tick the boxes for: [ Teke from Application Height mm
Minimize to Jobsize
M Minimise to Jobsize [JRotary Attachment : —|
. Material Settings
M Enhanced Geometries 5 vt SEPETN BT
M Inner geometries first p— o @ @ oz Q@ 200

ii.  Check the Process Options. Our defaults: Fraces Qptions
Standard v | Process Mode

o
P Mode: Standard = | s00dpi v | Resolution ' " 2
rocess iode anaar ; pi g F § @

ager. marking cutting eaoraving

None v | Cutline
Resolution: 500DPI*

OrderedDith v | Halftone

i . . O t Shoulder flat
Halftone: Ordered Dithering ClF vertcaly L - :
*Note: Vectors will not transmit below 333 zzzgizg’lflmem 2 Adjust S -
DPI, but higher resolution = longer etching Hinergeametries fist
time. Higher isn’t necessatrily better, Displays Size Templates
i i [J Quick Print
particularly on wood. 500DP!I is the best D 2 0

option if you’re unsure.
6. Send your job to JC: Click > >

7. Open JC (glowing on the taskbar) ——\
H QO Type here to search O Um0
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How to run a job on the laser cutter

Job Control °

e i Job Queue
' List of printed files

Material Settings
(of Plate)

Click ‘Update’ to . &N
: 'S a Preview
Use this to check job

see cutting time =2~
Note: <1hr per day has transmitted
unless permission given Laser Position Crosshairs correctly, with red/blue
by MakerSpace staff (will appear once connected) Laser Bed lines or black etches

If your job does not appear in the Job Queue, or the Preview doesn’t show red/blue lines or black etches,
refer to the Troubleshooting section.

Operating the Laser

1. Turn on the laser using the key provided.
2. Turn on the exhaust by holding down the green button on the wall switch for a couple of seconds.
MAKE SURE the green light is ON.
3. Ensure the bed is lowered before placing materials in the laser. Smooth the material so that the
surface is as level as possible, using the vacuum bed if required.
4. FOCUS the laser by positioning the laser dot over your material using the laser keypad. Once
positioned manually focus the head using the focusing tool.
5. Drag your job from the Job Queue onto the Plate.
6. Double check the correct material is selected in JC. You can only use one material per plate.
7. Find a MakerSpace laser mentor or staff member who will check your material and
settings before enabling your card.
é— 8. Click the USB button in JC to connect the computer and laser.
9. Move the laser dot over the material to any corner (or the centre) of your planned job
position using the keypad. You should see this reflected in real-time crosshairs on JC.
10. Drag your job to snap to the crosshairs. Preview your artwork and its relative
' J\ (—— positioning using the eye symbol in JC.
11. Use the laser keypad to move laser head around your job to check for collisions and
ensure you don’t run out of material.
12. Close the laser cutter door.
13. Press the ‘Play’ button to run the machine.
14. STAY WITH THE MACHINE while your job is running and be alert for unusual flame or
fumes.
15. After your job is complete WAIT 1 min for the fumes to clear BEFORE opening the door.

Notes
e You can run your job again using Ctrl-A = Ctrl-R and then Play. You may also run the cut line again
by right clicking and choose “Repeat cut lines”. NOTE: This will restart the laser immediately.
e If you are positioning using a jig you can use a job marker to make sure jobs register to this position.
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In the event of an emergency

In the event of a fire or excessive fumes where there is risk
of damage to people or equipment, the operator is
responsible for shutting down the laser cutter and taking
steps to ensure the fire/fumes does not spread.

1. HIT THE EMERGENCY STOP BUTTON.

2. FIRE: TURN OFF THE EXHAUST. Leave the lid closed
until you have the extinguisher/fire blanket ready. If the
fire is very small (less than 30cm) and can be safely
extinguished by smothering it, use the fire blanket. For
larger fires use the CO: fire extinguisher.

EXCESSIVE FUMES: Leave exhaust running. Do not
open the lid or resume cutting until you have notified
technical staff/mentors.

3. There should be a MakerSpace staff member/laser
mentor nearby at all times. Immediately let them know that there has been an incident, in person,
and assist with incident reporting if necessary. They will lock out the machine and follow up with out-
of-service procedures. If you think you’ve broken something or done something wrong, don’t be
embarrassed! It's more important that you let a staff member know so that the machinery can be
reinstated and policy can be updated.

4. Let security know. In the event of a fire or risk of serious injury, security staff must be informed.

User Agreement

#——
There is a small list of things we expect of users. Honouring

laser maintenance will secure your access to this machine.
Failing to honour this list will result in staff disdain,
equipment malfunction and revoked access.

e Lower the laser bed before removing full sized or large
sheet material.

o« Remove all offcuts on the laser bed before leaving the
machine.

e Ask a staff or mentor if you need to retrieve any items
below the laser bed.

o Alert staff/laser mentors if you are cutting/etching something that produces surface marking leading
to the extraction vents. They will perform lens maintenance.

o Contact MakerSpace staff if you notice improper function of the machine.

o Delete your file from the desktop/downloads/JC.

e Turn off the laser using the key and remove your ID card before leaving the MakerSpace.
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Stuck?

JC Errors & Fixes

“Too many jobs on the plate/job
cannot fit on the plate”

Make sure the plate is clear before dropping in additional artwork.
Alternatively, your art-board may be too big for JC. Resize to the parameters
specified in this document.

“Plate parameters cannot be found”

There are inconsistencies between the plate and your print profile. Place on
plate and manually select the material in JC.

Your job is not found in JC print
queue

If you have selected an irregular print resolution your print may be hidden in
the queue. Select ‘Show all’ below the queue to find the print.

Print-preview or JC displays only etch
lines where there should be cuts, or
shows as an empty job.

The most common error. Check for document colour settings, cut line
colour/stroke weight and clipping masks and print resolution. If that fails,
check both your document resolution (File > Document Setup) and print
resolution (lllustrator Print dialog > Advanced), if Medium is selected change
to High. If that fails, try to paste into another doc and check again. If that
fails, ask MakerSpace staff.

The laser will not respond or there are
no crosshairs on the JC plate

The laser is not turned on or connected to JC. Use the ‘USB’ shaped button
to reconnect.

| can’t see the plate, | can only see
my job

You have double clicked your artwork in JC. Press ‘esc’ to return to the
plate.

“No jobs to cut”

You need to reset your job (Ctrl-R) before re-running a job.

“No response from laser”. Check if
engraver is connected to the correct
COM port and switched on.”

Find a laser mentor or technical staff to swipe their access card.

Operational Errors & Fixes

$*$!@!@ lens collision, fire or
excessive smoke

Stop the laser using the key shut off. In case of fire open the lid and
extinguish. In case of smoke let the extraction run before opening the lid.
Contact a MakerSpace staff member before resuming the machine.

Laser not cutting all the way through
material

Check the laser is in focus and the material is flat. Run the cut lines again. If
problem persists, see MakerSpace staff.

Printer does not home

The lid must be closed as part of the initialisation homing process.

Air-assist is not functioning

Check with MakerSpace staff.

Etches are weaker toward edge of the
material.

Check with MakerSpace staff.

| need to be more precise about my
job placement. How can | achieve
this?

In lllustrator, use positioning marks (RGB Cyan, 0.001mm hairline vector),
then in JC use the job X/Y coordinates or use drag-down rulers (the laser
bed must be correctly placed to use this feature accurately). You can also
place job markers to save job positions.
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